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Фонд оценочных средств (POC) является элементом системы оценивания сформированности компетенций у обучающихся B целом 

или на определенном этапе ее фОрМИрОБЗ}ШЯ. 

ФОС разрабатывается в соответствии с рабочей программой (РП) дисциплины и включает в себя набор оценочных материалов для 

проведения текущего контроля успеваемости и промежуточной аттестации по дисциплине. 

1. Компетенции и результаты обучения, формируемые в результате освоения дисциплины 

Код и наименование результатов 

обучения (планируемые результаты. 
Критерии оценивания результатов обучения 

Компетенция Индикатор компетенции 
обучения, характеризующие этапы Удовлетворите | Неудовлетворител 

формирования компетенций) Отлично Хорошо льно BHO 

ОПК-4. Способен ИОПК-4.1. Обладает OP-4.1.1. Знать методы структурного | Имеет общее Имеет общее Имеет слабое Неимеет 

участвовать в разработке | необходимыми знаниями проектирования представление о | представление | представление | представления O 

технической нормативной базы методах о методах. о методах методах 

документации профессиональной структурного структурного структурного структурного 

программных продуктов | деятельности проектирования, | проектировани | проектировани | проектирования 

и программных знает я я 

комплексов особенности HX 

применения 

OP-4.1.2. Знать метод SADT Имеет общее Имеет общее Имеет слабое He имеет 

представление о | представление | представление | представления O 

методе SADT, о методе SADT | о методе SADT | методе SADT 

знает 

особенности его 

применения 



ИОПК-4.2. Применяет знания | OP-4.2.1. Уметь проектировать Умеет Умеет Допускает Не умеет 

нормативной базы в системы БД методами структурного | безошибочно проектировать | серьезные проектировать 

профессиональной проектирования проектировать системы БД ошибки при системы БД 

деятельности системы БД методами проектировани | методами 

методами структурного | и систем БД структурного 

структурного проектировани | методами проектирования 

проектирования | я, HO допускает | структурного 

незначительны | проектировани 

е ошибки я 

ИОПК-4.3. Разрабатывает OP-4.3.1. Уметь строить SADT- Умеет Умеет строить | Допускает He умеет строить 

техническую документацию, модели безошибочно бЗАРТ-модели, | серьезные ЗАРТ-модели 

связанную с строить SADT- но допускает ошибки при 

профессиональной модели незначительны | построении 

деятельностью е ошибки SADT-mopeneit 



2. Этапы формирования компетенций и виды оценочных средств 

Компетенции, формируемые в результате обучения дисциплине «Дискретная 

математика», при текущем контроле проверяются все сразу на основе материала 

изучаемых в течение семестра тем лекционных и практических занятий. 

N Этапы формирования компетенций Код и наименование Вид оценочного средства 

- (разделы дисциплины) результатов обучения (кесты, задания, кейсы, вопросы и др.) 

Контролируется на основе 1. Лабораторная работа №1. 

1 |материала Темы 2, Темы 3, Темы 4, ОПК-4. 2. Лабораторная работа Ne2. 

Темы 5 

[Контролируется на основе 1. Лабораторная работа Ne2. 

2 |материала Те-мы 4, Темы 5, Темы 6, ОПК-4. 2. Лабораторная работа Ne3. 

Темы 7 3. Лабораторная работа №4. 

[Контролируется на основе 1. Лабораторная работа Ne2. 

3 |материала Те-мы 4, Темы 5, Темы 6, ОПК-4. 2. Лабораторная работа Ne3. 

Темы 7 3. Лабораторная работа №4. 

3. Типовые контрольные задания или иные материалы, необходимые для 

оценки образовательных результатов обучения 

3.1. Типовые задания для проведения текущего контроля успеваемости по 

дисциплине 

Требования к лабораторным работам 

Требования к лабораторной работе 1: 

1. Построить SADT-Momens BCeX — организационных — (выполняемых — людьми, 

организациями, подразделениями) бизнес-процессов, выделенных в техническом 

задании. Если существует бизнес-процесс, частями которого являются бизнес- 

процессы технического задания, можно представить одну общую ЗАРТ-модель. 

Модели должны отражать новое видение процессов с участием будущей 

информационной системы (ИС). 

Листовые блоки модели с участием ИС должны соответствовать одной логической 

транзакции (единой непрерываемой единице диалога, выполняющей законченную работу 

с данными одного человека). 

Для стыковки организационных $АОТ-моделей с будущими моделями функций 

ИС (DFD, FHD) можно либо использовать одинаковые наименования блоков SADT и 

функций, либо указать наименования функций ИС в качестве специфических механизмов 

ЗАРТ-блоков. 

Можно (но это He является обязательным) придумать модели, отражающие старое 

видение процессов (как бы 10 реинжинирингоа). 

2. Утвердить $ЗАРОТ-модели бизнес-процессов (Ha бумаге) у преподавателя (B 

дальнейшем необходимо иметь их при себе при любых контактах с преподавателем 

по поводу выполнения последующих лабораторных работ). 

Требования к лабораторной работе 2



1. Подготовить и привести в соответствие информационные схемы предметной 

области (как в репозитории, так и в словаре Oracle), построенные в ходе 

лабораторных работ по курсу «Базы данных». 

В частности должны быть обеспечены: 

® — ЕК-схема в нотации Oracle Designer (Баркера); 

® реляционная схема в репозитории и словаре Oracle, включающая 

определения таблиц, представлений, последовательностей, триггеров и 

ограничений целостности. 

Чтобы было меньше проблем в дальнейшем, в идеале следует повторить весь 

процесс проектирования БД B прямом направлении (от ERD 10 реляционных схем), 

максимально добиваясь автоматизма преобразований (DDT, генератор DE) и 

минимизируя ручную доводку. 

При этом B обязательном порядке (опять же чтобы He было проблем в дальнейшем) 

в каждой таблице обязан быть первичный ключ. Он должен быть либо суррогатным 

ключом, либо (B случае таблиц, реализующих связи M:N) — группой из двух внешних 

ключей, ссылающихся на суррогатные ключи. 

2. Построить РМ-модель предметной области, определив функциональные роли BCEX 

пользователей и процессы (функции), соответствующие логическим транзакциям. 

Декомпозицию процессов в РМ следует проводить до тех пор, пока не будут 

получены функции, целиком выполняемые пользователем одной роли. Если при этом они 

не будут элементарными (реализуемыми с помощью одного окна диалога), дальнейшую 

декомпозицию лучше провести в DFD или FHD. 

3. Утвердить РМ-модель (на бумаге) у преподавателя (B дальнейшем необходимо 

иметь ее при себе при любых контактах с преподавателем по поводу выполнения 

последующих лабораторных работ). 

4. Для сложных функций (включающих не одно окно диалога) построить DFD- 

модели. 

5. Для всех функций РМ-модели построить ЕНО-модели. 

Листьями этих моделей должны быть функции, чьи задачи решаются с помощью 

одной формы (возможно с подформами). 

Если существует бизнес-процесс, частями которого являются бизнес-процессы 

технического задания, можно представить одну общую ЕНО-модель. 

Для функций-листьев указать использование множеств сущностей и атрибутов 

ЕКР-модели. 

Полезно перед этим представить эскиз OKHA, определить master и detail компоненты 

модуля, для каждого компонента модуля определить base H, возможно, lookup таблицы. 

(Для знакомства с особенностями диалога и структурой ОЕ-модулей обратитесь к файлу 

"ОР ОЕ Generator.doc" в каталоге Jlaboparopun\DOCS.) 

Использование данных в функциях определяется пока на уровне множеств 

сущностей ЕК-модели и их атрибутов. Поскольку сейчас ничего нельзя сказать об 

использовании множеств связей, действия с ними необходимо не забыть указать позже на 

‘уровне использования таблиц в модулях. 

6. Утвердить DFD- и ЕНО-модели (на бумаге) у преподавателя (B дальнейшем 

необходимо иметь ее при себе при любых контактах с преподавателем по поводу 

выполнения последующих лабораторных работ).



Построить B Matrix Diagrammer (MD) и применять для контроля использования 

данных матрицы “Business Functions to Entities” и “Business Functions to Attributes”, 

а для контроля использования функций - “Business Units 10 Business Functions”. 

Требования к лабораторной работе 3 

Для освоения инструментов Oracle Designer и методики проектирования и 

тенерации интернет-приложений в виде интерактивных форм с применением Oracle 

Forms Developer предлагаются следующие источники информации: 

Колетски П., Дорси П. Oracle Designer. Настольная книга пользователя. — М.:, Изд- 

во "ЛОРИ", 1999. — 592 с. (Избранные главы этой книги есть в электронной 

библиотеке факультета информатики). 

Online Help Oracle Designer. 

Бабанов А.М. Технология разработки программного обеспечения: структурный 

подход: Учебное пособие. — Томск: Изд-во НТЛ, 2006. — 220 с. (Достаточно большое 

количество экземпляров этой книги есть в Научной библиотеке ТГУ как в 

читальном зале, так и на абонементе). 

Файл ОР ОЕ Generator.doc в каталоге Лаборатории\р0ОС$. 

Используя Application Design Transformer создать набор модулей-кандидатов из 

данных анализа (Function Hierarchy Diagrammer или Dataflow Diagrammer). 

Параметры генерации: 

® — Сепега!е Modules = Modules; 

® — выберите Start Function, которая будет использоваться как корень иерархии 

функций; чтобы сгенерировать все функции в пределах текущей прикладной 

системы, оставьте это поле пустым; для определения Start Number (номера 

тенерируемого модуля) при генерации отдельного модуля используйте кнопку 

Find highest. 

® — выберите язык модуля Screen = Oracle Forms, Report = Oracle Reports, Utility = 

PL/SQL 

Используя RON (Repository Object Navigator) или ОЕ (Design Editor) примите или 

отклоните модули-кандидаты. Для этого установите свойство модулей Candidate? B 

‘№’ или удалите их. Любые модули-кандидаты, которые Вы He примете, останутся 

модулями-кандидатами. 

Внесите коррективы в значения свойств модулей — кандидатов. В названиях модуля 

(свойства Маше и Implementation Name) должны использоваться только латинские 

символы и их длина не должна быть более 8 знаков. 

Спланируйте структуру модулей. С помощью Design Editor создате определение 

модулей (Module Diagrams). 

Генерация Oracle Еопп5-приложения: 

® — открыть DE; 

® — вокне Navigator выбрать закладку Modules; 

® — правой кнопкой мыши щелкнуть по генерируемому модулю; 

® — выбрать альтернативу меню Generate. ..; 

® в разделе Preserve Layout должен быть выбран вариант «Noy, если вы создаете 

новое приложение и вариант «Yes» с указанием в поле Source Form Маше 

файла уже созданного приложения;



® — настроить опции генерации (кнопка Options. ..) 

на вкладыше Dependencies в разделе Source используются настройки по 

умолчанию; 

на вкладыше Form Options в поле Destination оё generated files указать путь до папки, куда 

тенерируется ваше приложение; 

7. 

10. 

на вкладыше Compile параметр Compile Form/Menu = №; 

на вкладыше Run параметр Run form automatically=No; 

остальные параметры по умолчанию. 

® — выполнить генерацию — кнопка Start. 

Компиляция и просмотр Oracle Еопп5-проекта выполняется в среде Oracle Forms 

Developer: 

® — Перед использованием Oracle Forms запустить Forms Developer —> Start OC4J 

Instance; 

® — Компиляция модулей осуществляется B Forms Builder (Forms Developer —>Forms 

Builder); 

Компиляция модулей B Forms Builder: 

® — При первичном использовании Forms Builder необходимо установить браузер, 

который будет использоваться для просмотра и работы с формами приложения 

Edit -> Preferences... -> Runtime -> Web Browser Location = C:\Program 

Files\Mozilla Firefox\firefox.exe; 

® — Открыть нужный модуль File -> Open; 

® — Соединиться с БД File -> Connect.. -> указать параметры соединения; 

® — Выполнить компиляцию модуля Program -> Compile Module; 

® — Запустить приложение Program -> Кип Form. 

Для всех модулей построить адекватные диаграммы данных и диалога. 

Воспользовавшись предлагаемой методикой, разработать предварительный проект 

модулей и — отдельные — черновые — Огтас!е_Еопп5-приложения IS — них. 

Они должны обеспечивать полное функционирование ИС, возможно без особого 

блеска и интеллекта. 

Требования к лабораторной работе 4 

Систематическое изложение методики совершенствования ОЕ-приложений дается B 

е — Файл ОР ОЕ Generator.doc в каталоге Лаборатории\0ОС5. 

Воспользовавшись предлагаемой методикой, разработать окончательный проект 

модулей и законченное единое Oracle Forms - приложение для индивидуальной 

предметной области. 

OHO должно обеспечивать полное функционирование ИС с идеальным диалогом и 

интеллектом (ничего лишнего, все по делу и удобно). 

Можно сгенерировать несколько приложений (Oracle_ Forms - проектов) для 

каждой роли пользователей по отдельности. 

3. 

4. 

Для правильной организации связи между модулями вашего приложения, все 

сгенерированные модули должны находиться в папке C:\DATA\oracle\forms. B 

рамках одного сеанса работы модули генерируются в данную папку. По окончанию 

сеанса все результаты работы копируются на личный диск. 

В обязательном порядке необходимо использовать:



® — зоны с разными стилями расположения; 

® — широкий спектр типов элементов управления; 

® — группы элементов управления; 

® — сложенные (stacking) области с закладками; 

® — диалоги свойств; 

® — диалоги запросов; 

® — диалоги LOV; 

® — экран запуска; 

® — значения по умолчанию; 

® — горячие клавиши; 

® — кнопки; 

® — подсказки (hints); 

® — меню. 

4. Методические — материалы, — определяющие — процедуры — оценивания 

образовательных результатов обучения 

4.1. Методические материалы для оценки текущего контроля успеваемости по 

дисциплине. 

Для оценки лабораторных работ используется расширенная шкала оценивания, 

приведенная ниже в таблице. 

Перевод B 
Форма записи | Численное . 

Оценка Критерий оценивания традиционную 
прописью значение 

шкалу 

Обучающийся показал творческое 

отношение к обучению, в совершенстве 

овладел всеми теоретическими 
5+ Отл-плюс 53 

вопросами, показал Bce  требуемые 

умения и навыки в — работе с 

программными продуктами. Отлично 

5 Отлично 5,0 Обучающийся показал отличный 

уровень владения всеми теоретическими 

вопросами, показал  все  требуемые 
5- Отл-минус 4,7 

умения и навыки в — работе с 

программными продуктами. 

4+ Хор-плюс 4.3 Обучающийся овладел всеми 

4 Хорошо 4,0 теоретическими — вопросами, частично 
Хорошо 

показал основные умения и навыки B 
4- Хор-минус 3,7 

работе с программными продуктами. 

3+ Уд-плюс 33 Обучающийся овладел всеми 

теоретическими — вопросами, частично 
Удовлетворительно 

3 Удовл. 3,0 показал основные умения и навыки B 

работе с программными продуктами. 



3- Уд-минус 

Обучающийся имеет недостаточно 

тлубокие знания 10  теоретическим 

разделам дисциплины, показал не все 

основные умения и навыки в работе с 

программными продуктами. 

Минимально возможный  допустимый 

уровень владения предметом. 

2+ Неуд-плюс 

Обучающийся — имеет — существенные 

пробелы по отдельным теоретическим 

разделам дисциплины и He владеет 

основными умениями и навыками в 

работе с программными продуктами, HO 

с возможностью повторной пересдачи 

экзамена 

%) Неудовл. 

Обучающийся — имеет — существенные 

пробелы по отдельным теоретическим 

разделам дисциплины и не владеет 

основными умениями и навыками в 

работе с программными продуктами, 

требуется повторное изучение 

ДИСЦИПЛИНЫ 

`Неудовлетворительно 

4.2. Методические материалы для проведения промежуточной аттестации по 

дисциплине. 

Оценка за промежуточную аттестацию по дисциплине 

среднеарифметическая по итогам текущего контроля успеваемости при условии сдачи 

контрольной точки 4 (лабораторная работа 4) на положительную оценку. 

выставляется  как 

Для оценки промежуточной аттестации используется традиционная шкала 

оценивания. Перевод из расширенной шкалы в традиционную приведен в таблице выше. 


